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Introducing ArcGIS 3D Analyst: 
Mount St. Helens - Before and After 

 
 

 
US Geological Survey – Mount St. Helens from north looking over Mount Margaret 

 
In this lesson you will be introduced to some of the functionality of the 

3D Analyst extension for ArcGIS. 
 

 
Scenario:  On May 18th, 1980, the long dormant Mount St. Helens volcano erupted and over the course 
of several weeks the blast transformed the surrounding landscape from forested slopes into lava, ash, 
and mud covered desolation.  Using the 3D Analyst extension, you will perform cut and fill calculations 
on the mountain, look at lines of sight, create contour lines, and generate slope, aspect, and hillshade 
maps. 
 
This lesson requires special datasets that are included in the archive with this document: 

1. hbefore (grid) 
2. hafter (grid) 
3. observation (shapefile) 

 

 
 
How is 3D Analyst used? 
 
With the ArcGIS 3D Analyst extension, you can perform a variety of tasks such as: 
 

• Visualize your data in three dimensions 
• Creating surface models from different data sources (elevation, temperature…) 
• Determining height at any location on a surface 
• Finding out what is visible from an observation point 
• Calculating the volumetric difference between two surfaces (cut and fill) 
• Working with 3D vector features to make realistic models of the 3D world 
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Types of data used in 3D Analyst 
 
1. Grids (raster data) 
 
Raster data is different from vector data in that raster data is a cell-based representation of map features 
called a grid.  A grid is comprised of cells organized into rows and columns.  Each cell in the structure has 
a value.  A group of cells with the same value represents a feature.  

• Grids represent entities 
• Grids are made of cells 
• There is a value applied to each cell 

 
2. TINs (Triangulated irregular networks) 
 
TINs represent surfaces using contiguous, non-overlapping triangle facets.  One can estimate a surface 
value anywhere in the triangulation by averaging node values of nearby triangles, giving more weight and 
influence to those that are closer.   
 
While the cell size of a grid is consistent throughout the entire grid, the size of the triangles in the TINs 
can vary.  They are usually more detailed in areas where the surface is more complex and less detailed in 
areas where the surface is simpler.   
 
A TIN dataset contains points with x, y, and z values and a series of edges joining these points to form 
triangles. The triangular mosaic forms a continuous faceted surface, which can be used to analyze and 
display terrain and other types of surfaces. TINs offer an alternative to the raster data model for 
representing surfaces. 
 
In general, Grids tend to be used for smaller, regional applications while TINs are used for more detailed, 
larger scale applications.   
 
 
Let’s Get Started 
 
1. Start ArcMap and from the ArcMap window, choose “A new empty map.” 
 

 
 
2. From the Tools menu, choose Extensions and check off 3D Analyst.  Click Close. 
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3. Click on the Add Data button  and navigate to mtsthelens folder for this lesson (ask your teacher 
if you are unsure where this is).  

 
4.  Add the hafter and hbefore grids to your table of contents. 
 
5. Turn on  both the grids and examine the information.  Change the order that they appear in the 

table of contents by dragging one above or below the other.  
 
6. This would be a good time to save your project.  To do this, go to the File menu and choose Save 

As.  Give your project a name and save it to the project folder. 
 
Creating a Hillshade 
 
 
You can see from looking at the elevation grids the elevation on the north side of the mountain decreases 
drastically.  Let’s take a quick look at what Mount St. Helens looks like when you apply an illumination to 
the surface.  This will help you get a better idea of what the terrain looks like there. 
 
 
1. Turn off  the visibility for the grids.  Make the hbefore grid the active layer (appears highlighted in 

blue compared to the other layer). 
 
2. Add the 3D Analyst toolbar by going to the View menu, Toolbars, and finally clicking beside 3D 

Analyst. 
 
3. From the 3D Analyst toolbar, click the 3D Analyst drop down menu and select Surface Analysis 

then Hillshade.  In the dialog box that appears, leave the settings as they are and click OK.  A new 
grid will be added to the table of contents. 
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4. Turn on  the visibility for the new grid.  What are you looking at?  This is a hillshade of Mount St 

Helens before the eruption. The sun (illumination) angle is at 315 degrees (from the north west) and 
is at an altitude of 45 degrees.   

 
5. Repeat the same steps as above and create a hillshade for the hafter grid.  Try playing around with 

different sun angles and altitudes. 
 
6. When you are done, remove all the layers from the view except for the hbefore and hafter grids (the 

original layers that you added in). 
 
 
 
Converting to TIN 
 

In order to work with the data in 3 dimensions, you are going to have to convert it to a TIN. 
 
1. Make the hbefore layer active.  From the 3D Analyst menu, choose Convert, Raster to TIN.   
 
2. In the dialog box that appears, change the name of the new TIN to before_tin.  Make sure that that 

the hbefore grid is listed beside Input raster and that your TIN is being saved in the c:\mtsthelens 
folder!  

 
3. Leave the z tolerance as it appears. Click OK. 
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4. Convert the hafter grid to a TIN as well.  Call it after_tin. 
 
5. Turn on  the visibility for both the TIN layers.   
 

6. Zoom in  to each of them and notice that they are now made up of a series of different sized 
triangles, not a regular grid of values. 

 
 
 
Working in a 3D Scene 
 

1. Click the ArcScene button  to open the 3D application. 
 

2. Click on the Add Data button . Select both the before and after TINs using the Ctrl key and add 
them to the 3D scene. 

 

 
 
3. Turn on  and off  the layers to see what they look like in 3 dimensions. 
 

4. Using the Navigate tool , rotate, turn, and zoom in on the TINs in your 3D Scene.  
 

a. To rotate and flip the TIN, make sure the Navigate tool is active.  Click and hold inside the 
3D scene and move your cursor around.   

b. To zoom in and out, make sure the Navigate tool is active, hold down the right mouse 
button and drag the cursor down to zoom in or drag it up to zoom out. 

 
 

Now that you are familiar with how to navigate within a 3D Scene, 
Let’s try working with some of the functionality of 3D Analyst. 
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Extruding features 
 
 
Sometimes, seeing features from a 3D perspective is difficult if there isn’t a great deal of difference in 
elevation between each of the features.  In order to make this difference more apparent, 3D Analyst 
allows you to do what is called Vertical Exaggeration on all the layers in the 3D Scene.  This vertical 
exaggeration factor is consistent for all the layers and their features inside the scene. 
 
 
1. In the ArcScene View menu, select Scene Properties.  
 
2. Click the General tab.  
 
3. Click the Vertical Exaggeration dropdown arrow and change the Vertical exaggeration factor to 2. 
 
4. Click OK. 
 
 

 
 
 
3. Turn your layers on and off – what happened to your view of Mount St Helens?  Experiment with 

the Vertical exaggeration factor and see what happens in ArcScene. 
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Area and volume calculations 
 

3D Analyst allows you to calculate the area and volume of TIN data sources. 
 
1. Return to ArcMap. 
 
2. Make the Before_tin the active layer.  From the 3D Analyst menu, choose Surface Analysis then 

Area and Volume.   
 
3. Leave the height of plane value as it appears (the height is in meters). 
 
4. You want to choose to calculate statistics ABOVE the plane.   
 
5. Click on Calculate Statistics. 
 

Write the values here: 
2D area: 
 
Surface area: 
 
Volume: 

 
 
**Surface area is measured along the slope of a surface, taking height into consideration.  The area 
calculated will always be greater than simply using the 2D planimetric extent of the model.  To envision 
this, think of a pyramid.  Looked at from directly above, it appears to be a square, the area of which is 
less than the surface area of the pyramid.  When compared to planimetric area, surface area gives you 
an idea about surface roughness.  The larger the difference between the two values, the rougher the 
surface. 
 
 
6. Now make the After_tin layer active and follow the steps to calculate the area and volume statistics 

for this layer. 
 

Write the values here: 
2D area: 
 
Surface area: 
 
Volume: 

 
 

What differences are there?  What can you say about the change in area/volume after the explosion? 
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Cut and fill analysis and assigning base heights 
 
 

Cut-fill analysis determines how much material is lost or gained in an area by comparing two surface 
models of it; one before a change and one after. 
 
Cut-fill is useful in construction projects for estimating how much material needs to be moved.  By 
comparing the present surface with a proposed surface, you can determine how much dirt needs to be 
hauled out. 

 
Cut-fill is also useful in environmental applications.  Investigating deposition of silt in front of a dam or a 
river delta can help determine when and where to dredge.  Two different water table surfaces can be 
used to estimate changes in groundwater volume over time.   

 
 

1. Return to ArcScene, hold down your Ctrl key and make both the Before and After TINs active. 
 
2. From the 3D Analyst menu, choose Surface Analysis then Cut /Fill.   
 
3. From the drop down list, choose Before_tin as the “before surface” and the After_tin as the “after 

surface”.  Click OK. 
 

 
 

 
ArcScene will do some calculations (this might take a minute or two, depending on the speed of your 
computer).  You will then have a new layer added to your Table of Contents.   
 
 
4. Turn on the visibility for this new layer and turn off the visibility for the other TINs.  You will notice 

that the new TIN is just a flat surface.  The reason is that it doesn’t know from which surface it should 
take its base heights. 

 
 
This is not the same as extruding features!  Base heights are a set of reference heights for a layer.  They 
are defined by an expression (mathematical equation), a surface, or in the case of 3D feature layers, the 
3D shapes themselves.  All layer types require that base heights be defined. 

 
 

5. Make the new cut-fill layer the active layer.  Right click on the layer and select Properties.   
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6. Click the Base Heights tab.  Use the drop-down menu for obtain heights for layer from surface and 
choose the After_tin layer.  Click OK. 

 

 
 

7. Use the Navigate tool  to zoom in and out of the cut fill layer and to move it around.   
 
What are you looking at here?  What do the blue areas represent?  What do the red areas represent?  
Why are there areas of Net Loss along the base of the mountain?  What features could have been “lost” 
here? 
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8. Try this…go back to the Properties for the cut fill layer and change the Surface to the Before_tin.  
Click on OK. 

 
How does this change the way you view the cut fill layer?  Is this way of viewing the layer more 
representative of the data that you are trying to show? 
 
 
 
 
 
 
 
Analyzing visibility 
 
 
Determining what is visible on a surface from a set of one or more locations is useful for a wide range of 
applications, from estimating real estate value to locating new cellular phone towers. 

 
Line of sight 
 
The line of sight tool tells you whether a given target is visible from a point of observation.  If the target is 
obscured, you’re given the coordinates of the first obstruction.  You also find out what is visible along the 
line of sight.   
 
 
1. Return to ArcMap, go to the Insert menu and select Data Frame.   
 
2. Add the following layers to your New Data Frame: 

 
After_tin (from the c:\mtsthelens directory) 
Observation.shp (from ArcCanada 3.0 disk4/3d/mtsthelens) 

 
 

3. Turn on the visibility for both layers and make the After_tin the active layer. 
 

4. Choose the Line of Sight tool . 
 
5. In the dialog box, change the observer offset to 3 and leave the target offset at zero.  Close the box. 
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You need to specify how many units the observer and target positions will be offset above the surface.  
You typically don’t want to position the observer at ground level, which is where it will be if you give a 0.0 
offset.  Chances are not much will be visible.  Put it this way, if you set the offset height to zero, you are 
basically telling ArcView that you will be laying flat on the ground to observe your target.  The target might 
not have a height but if you are looking at cell phone towers, then you will have to adjust that height 
accordingly! Therefore 3 meters is a good estimation of a person’s height, combined with accounting for 
uneven terrain. 
 
6. Now, your cursor will turn into crosshairs.  Click and hold the crosshairs on the observation point 

(observation.shp) drag a line to the location of the target that you wish to observe, let’s say, the peak 
of the mountain, then release your mouse button.  A new line will appear. 

 
The red portion(s) of the line indicates that you will not be able to see those areas from the observation, 
the green lines means that you will. 
 
Play around with the Line of Sight tool.  List some real world applications where you think this 
technology would be useful. 
 
 
 
 
 
 
 
 
 
 
 
Viewshed: 
 

 
The last type of Visibility Analysis that you are going to look at is Viewshed.  Viewshed refers to the areas 
on a surface visible from one or more observation points.  For any visible position, you also discover how 
many observers can see that position.  With the viewshed function you cannot only control the height of 
an observer but also can provide constraints on how far, how high, and which direction it can look.   
 
1. Still in ArcMap, with both layers still visible, hold down your Ctrl key and make both layers 

(after_tin and observation) active.  From the 3D Analyst menu, choose Surface Analysis then 
Viewshed… 

 
2. Change the Input surface to After_tin and the Observer Points to observation.  Leave all the other 

values as they are and click on OK.  A new grid layer will be created where the red areas are not 
visible from the observation point and the green areas are.   

 
3. Convert the new raster grid to features (from the 3D Analyst menu) and save it in the project folder. 

The new layer will be added to your map.   
 
4. Bring up the Layer Properties and make a unique value legend, showing colours that best 

represent the areas that can and cannot be scene from the observation point. This can all be done 
under the Symbology tab. 
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5. Make this layer see through. To do this, click on the Display tab and set the transparency. Experiment 

with this until you find the right level of transparency for your map. 
 
 

Note: Transparency is measured as a percentage where 0 indicates NO transparency and 100 
indicates that the layer is COMPLETELY see through.  
 
 
How does the viewshed match up with the line of sight results?  What kind of applications would 
make good use of a viewshed analysis? 
 
 
 
 
 
 
 

Let’s Print! 
 

1. OK, let’s make a really nice layout…While you are still in the data view in ArcMap, turn off the 
visibility for the viewshed layer and turn on the after TIN.  With the observation layer active, use 
your Pointer tool to select the line of sight (light blue handles will appear around it). Right click on it 
and change it’s properties (i.e., colour or thickness) if you find it necessary.  

 
2. Make sure to change all your layer names to meaningful titles by making each layer active and 

double clicking on it to bring up the Layer Properties dialog box (use terms that a beginner map 
reader would understand). 

 
3. Select the Layout view by clicking the Layout button  located to the bottom left of the map view. 

Right click on a blank portion of the layout and select Page Setup. Change the layout from Portrait to 
Landscape.  

 
4. As usual, insert the title and scale bar… from the Insert menu. 
 
5. You are also going to add your line of sight as a profile view of Mount St Helens.  First, select the 

Interpolate Line  button and trace the line of sight (single click to start and double click to finish 
the line).  

 

6. Make sure that when you click on the Profile Graph tool  that it is visible, if not than go back to 
your Data View and make sure that your After_tin layer is active. (The Profile Graph Tool will take 
selected 3D lines from either the graphics of the active layer and create a graph that shows the height 
measured along the lines.). 

 
7. Right click on the graph and select Show on Layout. Resize and more the graph to a good place on 

your map. 
 
8. In the Profile Graph Properties dialog box (right click on it and select properties), change the title of 

the profile graph to something like “Profile of Mt. St. Helens - After”.  Leave all the other values as 
they appear.  Click on OK. 

 
9. Go back to your original Data Frame. Turn on the visibility for the before TIN.  
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10. Follow the same procedure to create a profile of the before_tin. 
 
11. Move your title, maps, profile graphs and legend components around and resize them to make a nice 

layout.  Go ahead and PRINT! 
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